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Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of

semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits,
software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and
damages incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents,
copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical
information described in this document, including but not limited to, the product data, drawings, charts, programs, algorithms, and
application examples.

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas
Electronics or others.

4. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics
disclaims any and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification,
copying or reverse engineering.

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended
applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.
“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; 

home electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 
“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication 

equipment; key financial terminal systems; safety control equipment; etc. 
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other 
Renesas Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a 
direct threat to human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious 
property damage (space system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military 
equipment; etc.). Renesas Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising 
from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual or other 
Renesas Electronics document. 

6. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General
Notes for Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the
ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation
characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of
the use of Renesas Electronics products outside of such specified ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products
have specific characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless
designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not subject to radiation resistance design. You are responsible for implementing
safety measures to guard against the possibility of bodily injury, injury or damage caused by fire, and/or danger to the public in the event
of a failure or malfunction of Renesas Electronics products, such as safety design for hardware and software, including but not limited to
redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.
Because the evaluation of microcomputer software alone is very difficult and impractical, you are responsible for evaluating the safety of
the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each
Renesas Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate
the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics
products in compliance with all these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or
losses occurring as a result of your noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use,
or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control
laws and regulations promulgated and administered by the governments of any countries asserting jurisdiction over the parties or
transactions.

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or
otherwise sells or transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this
document.

11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas
Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or
Renesas Electronics products.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly 
controlled subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 

(Rev.4.0-1  November 2017) 



How to Use This Manual

This manual describes the role of the CS+ integrated development environment for developing applications and sys-
tems for RL78 family, and provides an outline of its features.

CS+ is an integrated development environment (IDE) for RL78 family, integrating the necessary tools for the develop-
ment phase of software (e.g. design, implementation, and debugging) into a single platform.

By providing an integrated environment, it is possible to perform all development using just this product, without the 
need to use many different tools separately.

Readers This manual is intended for users who wish to understand the functions of the CS+ and 
design software and hardware application systems.

Purpose This manual is intended to give users an understanding of the functions of the CS+ to use 
for reference in developing the hardware or software of systems using these devices.

Organization This manual can be broadly divided into the following units.

1.GENERAL
2.FUNCTIONS
A.WINDOW REFERENCE

How to Read This Manual It is assumed that the readers of this manual have general knowledge of electricity, logic 
circuits, and microcontrollers.

Conventions Data significance: Higher digits on the left and lower digits on the right
Active low representation: XXX (overscore over pin or signal name)
Note: Footnote for item marked with Note in the text
Caution: Information requiring particular attention
Remark: Supplementary information
Numeric representation: Decimal ... XXXX

Hexadecimal ... 0xXXXX

All trademarks or registered trademarks in this document are the property of their respective owners.
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CS+ Code Generator 1.  GENERAL

1.  GENERAL

CS+ is an integrated development environment used to carry out tasks such as design, coding, build and debug for 
developing application systems.

This chapter gives an overview of the Code Generator.

1.1  Overview

The Code Generator, which is one of the components provided by CS+, enables you to output the source code (device 
driver programs, C source files and header files) necessary to control the peripheral functions (clock generator, port 
functions, etc.) provided by the microcontroller by configuring various information using the GUI.

There are 3 types of products depending on the supporting device *1.
*1 Code Generator Plug-in (for V850, 78K0, 78K0R, RL78/G12, G12, G14, G1A, I1A, L12, F12, F13, F14)

Code Generator/Pin View Plug-in (for RX, RL78 not listed in Code Generator Plug-n)
Code Generator Plug-in for RH850 (for RH850)

1.2  Features

The Code Generator has the following features.

(1) Code generating function
The Code Generator can output not only device driver programs in accordance with the information configured 
using the GUI, but also a build environment such as sample programs containing main functions and link directive 
files.

(2) Reporting function
You can output configured information using the Code Generator as files in various formats for use as design 
documents.

(3) Renaming function
The user can change default names assigned to the files output by the Code Generator and the API functions con-
tained in the source code.
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2.  FUNCTIONS

This chapter describes the key functions provided by the Code Generator along with operation procedures.

Remark In this chapter, an example where an RL78/L13 (ROM: 128KB) R5F10/WMG (80pin) is the target device 
is used to explain the key functions.

2.1  Overview

The Code Generator outputs source code (device driver programs) based on information selected/entered on CS+ pan-
els that is needed to control the peripheral functions (clock generator, port functions, etc.) provided by the device.

The following sections describe the operation procedures for Code Generator.

(1) Start CS+
Launch CS+ from the [Start] menu of Windows.

(2) Create/Open project
Create a new project (that defines a kind of project, microcontroller to be used, build tools to be used, etc.) or load 
an existing project.

(3) Open Peripheral Functions Panel
Open the Peripheral Functions panel used to configure the information necessary to control the peripheral func-
tions (clock generator, port functions, etc.).

(4) Enter Information
Configure the information necessary to control the peripheral functions (clock generator, port functions, etc.) in the 
Peripheral Functions panel.

(5) Confirm Source Code
Confirm the source code (device driver program) that reflects the information configured in the Peripheral Func-
tions panel.

(6) Output Source Code
Output the source code (device driver program) to the specified folder.

(7) Output Report Files
Output report files (a file containing information configured using Code Generator and a file containing information 
regarding the source code) to the specified folder.

(8) Save project
Save a project.
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CS+ Code Generator 2.  FUNCTIONS

2.2  Open Peripheral Functions Panel

The Peripheral Functions panel is opened to set the information necessary to control the peripheral functions (clock 
generator, pin functions, etc.) provided in the device.

To open the Peripheral Functions panel, double-click [Project name (Project)] >> [Code Generator (Design Tool)] >> 
[Peripheral Functions] (>> Peripheral function node) in the Project Tree panel.

Figure 2.1 Open Peripheral Functions Panel

Remark If an unsupported device is defined in the project for Code Generator, then ”[Code Generator (Design 
Tool)] node” will hide under [Project name (Project)] in the Project Tree panel.
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2.3  Enter Information

Configure the information necessary to control the peripheral functions (clock generator, port functions, etc.) in the infor-
mation setting area of the Peripheral Functions panel which is opened as described in "2.2  Open Peripheral Functions 
Panel”.

Remark When controlling multiple peripheral functions, repeat the procedures described in "2.2  Open Peripheral 
Functions Panel" through "2.3  Enter Information".

2.3.1  Input rule

Following is the rules for input to the Peripheral Functions panel.

(1) Character set
Character sets that are allowed to input are as follows.

(2) Number
Notations allowed when entering numbers are as follows.

ASCII 1-byte alphabet, number, symbol

Shift-JIS 2-byte alphabet, number, symbol, Hiragana, Katakana, Kanji and 1-byte 
Katakana

EUC-JP 2-byte alphabet, number, symbol, Hiragana, Katakana, Kanji and 1-byte 
Katakana

UTF-8 2-byte alphabet, number, symbol, Hiragana, Katakana, Kanji (include Chinese 
character) and 1-byte Katakana

Decimal number A numeric value that starts with a number between 1 and 9 and followed by num-
bers between 0 and 9, and the numeric value 0

Hex number A numeric value that starts with 0x and followed by a combination of numbers 
from 0 to 9 and characters from A to F (characters are not case sensitive)
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CS+ Code Generator 2.  FUNCTIONS

2.3.2  Icon indicating incorrect entry

When performing code generation, if you enter an invalid string in the Peripheral Functions panel, or a required input is 
missing, then a  icon displays next to the incorrect input, and the text is displayed in red to warn that there is a problem 
with the input.

Figure 2.2 Icon Indicating Incorrect Entry

Remark If the mouse cursor is moved over the  icon, information regarding the string that should be entered 
(tips for correcting the entry) popups.
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2.3.3  Icon indicating pin conflict

If a conflict occurs between the pins while setting various peripheral functions in the Peripheral Functions panel, the  
icon is displayed at the location where the conflict occurs to warn the user of a conflict between the pins.

Figure 2.3 Icon Indicating Pin Conflict

Remark If the mouse cursor is moved over the  icon, information regarding the conflict between the pins (tips 
for avoiding the conflict) popups.
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2.4  Confirm Source Code

Confirm the source code (device driver program) that reflects the information configured as described in "2.3  Enter 
Information".

To confirm the source code, use the Code Preview panel that opens by double-clicking [Project name (Project)] >> 
[Code Generator (Design Tool)] >> [Code Preview] >> Peripheral function node >> Source code node (>> API function 
node) in the Project Tree panel.

Figure 2.4 Confirm Source Code

Remark 1. You can change the source code to be displayed by selecting the source file name or API function name 
in the Project Tree panel.

Remark 2. The following table displays the meaning of the color of the source code text displayed in the Code Pre-
view panel.

Remark 3. You cannot edit the source code within the Code Preview panel.

Remark 4. For some of the API functions, values such as the register value are calculated and finalized when the 
source code is generated (when the  button on the Peripheral Functions panel is 
pressed). For this reason, the source code displayed in this panel may not be the same as that would 
actually be generated.

Green Comment

Blue Reserved word for C compiler

Red Numeric value

Black Code section

Gray File name
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2.5  Output Source Code

Output the source code (device driver program) by pressing the  button on the Peripheral Functions 
panel.

The destination folder for the source code is specified by clicking [Code Generator Setting] tab >> [Generate File Mode] 
>> [Output folder] in the Property panel.

Figure 2.5 Output Source Code

Remark In order to both output source files and add them to the project (display the corresponding source file 
names in the Project Tree panel) when you click the  button, you must open the Property 
panel, and under [Code Generator Setting] tab >> [Generate File Mode] >> [Register files], specify 
"Register the generated files to the project".

Figure 2.6 Configure Whether to Register
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2.5.1  Set whether or not to generate source code

You can set the type of output API functions (all API functions or only initialization API functions) by selecting [Output all 
API functions according to the setting/Output only initialization API function] from [Code Generator Setting] tab >> 
[Generate File Mode] >> [API output control] in the Property panel.

Figure 2.7 Setting That Determines Type of API Functions

In the Code Generator, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Code Preview] >> Periph-
eral function node >> Source code node >> API function node in the Project Tree panel. “Setting That Determines 
Whether or Not to Generate Source Code” can be set in units of API functions by selecting “Generate Code/Not Generate 
Code” from the context menu, which is displayed by right clicking the mouse.

Figure 2.8 Setting That Determines Whether or Not to Generate Source Code
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Remark “Setting That Determines Whether or Not to Generate Source Code” can be confirmed by the types of 
icons that are displayed immediately to the left of the API function nodes.

Source code for the currently selected API function is generated.
If this icon is displayed next to the API function, the corresponding 
source code must be generated (it is impossible to change the icon to 

 ).

Source code for the currently selected API function is generated.

Source code for the currently selected API function is not generated.
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CS+ Code Generator 2.  FUNCTIONS

2.5.2  Change file name

In the Code Generator, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Code Preview] >> Periph-
eral function node >> Source code node in the Project Tree panel. The name of the file can be changed by selecting 
"Rename" from the context menu, which is displayed by right clicking the mouse.

Figure 2.9 Change File Name

Remark To restore the default file name defined by the Code Generator, select [Default] from the context menu.
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2.5.3  Change API function name

In the Code Generator, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Code Preview] >> Periph-
eral function node >> Source code node >> API function node in the Project Tree panel. The name of the API function can 
be changed by selecting "Rename" from the context menu, which is displayed by right clicking the mouse.

Figure 2.10 Change API Function Name

Remark 1. To restore the default name of the API function defined by the Code Generator, select [Default] from the 
context menu.

Remark 2. Some API functions (main, etc.) can not be changed the API function name.
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CS+ Code Generator 2.  FUNCTIONS

2.5.4  Change output mode

The Code Generator is used to change the output mode (Do nothing if file exists, Merge file, Overwrite file) for the 
source code by selecting [Code Generator Setting] tab >> [Generate File Mode] >> [File generation control] in the Prop-
erty panel.

Figure 2.11 Change Output Mode

The output mode is selected from the following three types.

Remark Note that if the [Merge file] option is selected, the number of left braces ("{") and right braces ("}") must 
match in the parts to be merged. When the numbers do not match, processing for correct merging is not 
possible.

Do nothing if file exists If a file with the same name exists, a new file will not be output.

Merge file If a file with the same name exists, a new file is merged with the existing file.
Only the section between "/* Start user code ... . Do not edit comment generated here */
" and "/* End user code. Do not edit comment generated here */" will be merged.

Overwrite file If a file with the same name exists, the existing file is overwritten by a new file.
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2.5.5  Change output destination folder

The Code Generator is used to change the output destination folder for the source code by selecting [Code Generator 
Setting] tab >> [Generate File Mode] >> [Output folder] in the Property panel.

Figure 2.12 Change Output Destination Folder
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2.5.6  Change text file encoding

The Code Generator is used to change the output destination folder for the source code by selecting [Code Generator 
Setting] tab >> [Generate File Mode] >> [Text file encoding] in the Property panel.

Figure 2.13 Change Output Destination Folder

Remark 'System' is set as the default setting. 
When 'System' is selected, the encoding follows to Windows setting.
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2.5.7  Change creation date

The Code Generator is used to change the creation date into the file header of the source code by selecting [Code Gen-
erator Setting] tab >> [Generate File Mode] >> [Creation date] in the Property panel.

Figure 2.14 Change Output Destination Folder
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2.6  Output Report Files

Output report files (a file containing information configured using Code Generator and a file containing information 
regarding the source code) by first activating the Peripheral Functions panel or Code Preview panel, then selecting [File] 
menu >> [Save Code Generator Report].

The destination folder for the report file is specified by clicking [Code Generator Setting] tab >> [Generate File Mode] >> 
[Output folder] in the Property panel.

Figure 2.15 Output Example of Report File "Function" (HTML File)

Remark 1. You can only use "Function" or "Macro" as a name of the report file.
See "2.6.1  Change output format" for details on the output format.

Remark 2. The output mode of the report file is defined in "Overwrite file".

Function.xxx A file that contains the information regarding the source code

Macro.xxx A file that contains the information configured using Code Generator
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2.6.1  Change output format

The Code Generator is used to change the output format (HTML file or CSV file) of the report file by selecting [Code 
Generator Setting] tab >> [Generate File Mode] >> [Report type] in the Property panel.

Figure 2.16 Change Output Format

Remark The output format of the report file is selected from the two types shown below.

HTML file Outputs in the HTML format.

CSV file Outputs in the CSV format.
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2.6.2  Change output destination folder

The Code Generator is used to change the output destination folder for the report file by selecting [Code Generator Set-
ting] tab >> [Generate File Mode] >> [Output folder] in the Property panel.

Figure 2.17 Change Output Destination Folder
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A.  WINDOW REFERENCE

This appendix explains in detail the functions of the windows, panels and dialog boxes of the Code Generator.

A.1  Overview

The Code Generator has the following windows, panels and dialog boxes.

Table A.1 Window/Panel/Dialog Box List

Window/Panel/Dialog Box Name Function

Main window This is the first window to open when CS+ is launched. This window is used 
to operate various components (design tool, build tool, etc.) provided by 
CS+.

Project Tree panel This panel displays the components of the project (microcontroller, design 
tool, build tool, etc.) in a tree structure.

Property panel This panel allows you to view the information on and change the setting for 
the node selected in the Project Tree panel.

Peripheral Functions panel This panel allows you to configure the information necessary to control the 
peripheral functions (clock generator, port functions, etc.) provided.

Code Preview panel This panel allows you to confirm the source code in accord with the settings 
of the Peripheral Functions panel.

Output panel This panel displays operation logs for various components (design tool, 
build tool, etc.) provided by CS+.

Save As dialog box This dialog box allows you to name and save a file.
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R20UT3104EJ0110

This is the first window to open when CS+ is launched. This window is used to operate various components (design tool, 
build tool, etc.) provided by CS+.

Figure A.1 Main Window

The following items are explained here.

- [How to open]

- [Description of each area]

[How to open]

- From the [start] menu, select [All Programs] >> [Renesas Electronics CS+] >>[CS+].

[Description of each area]

(1) Menu bar
This area consists of the following menu items.

Main window

(1)

(2)
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(a) [FIle] menu

(b) [Edit] menu

(c) [View] menu

Save Code Generator 
Report

Peripheral Functions panel/Code Preview panel-dedicated item
Outputs report files (a file containing information configured using Code Gener-
ator and a file containing information regarding the source code).

- The output format for the report file (either HTML file or CSV file) is selected 
by clicking [Code Generator Setting] tab >> [Generate File Mode] >> [Report 
type] in the Property panel.

- The destination folder for the report file is specified by clicking [Code Gener-
ator Setting] tab >> [Generate File Mode] >> [Output folder] in the Property 
panel.

Save Output-Tab Name Output panel-dedicated item
Saves the message corresponding to the specified tab overwriting the existing 
file.

Save Output-Tab Name 
As...

Output panel-dedicated item
Opens the Save As dialog box for naming and saving the message correspond-
ing to the specified tab.

Undo Property panel-dedicated item
Cancels the effect of an edit operation to restore the previous state.

Cut Property panel-dedicated item
Sends the character string or lines selected with range selection to the clip-
board and deletes them.

Copy Property panel/Output panel-dedicated item
Sends the character string or lines selected with range selection to the clip-
board.

Paste Property panel-dedicated item
Inserts the contents of the clipboard at the caret position.

Delete Property panel-dedicated item
Deletes the character string or the lines selected with the range selection.

Select All Property panel/Output panel-dedicated item
Selects all the strings displayed in the item being edited or all the strings dis-
played in the Message area.

Search... Code Preview panel/Output panel-dedicated item
Opens the Search and Replace dialog box for searching strings with the [Quick 
Search] tab selected.

Replace... Output panel-dedicated item
Opens the Search and Replace dialog box for replacing strings with the [Whole 
Replace] tab selected.

Project Tree Project Tree panel-dedicated item
Opens the Project Tree panel.

Property Property panel-dedicated item
Opens the Property panel.

Output Output panel-dedicated item
Opens the Output panel.

Code Preview Code Preview panel-dedicated item
Opens the Code Preview panel.
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(d) [Help] menu

(2) Panel display area
This area consists of multiple panels, each dedicated to a different purpose.
See the following sections for details on this area.

- Project Tree panel

- Property panel

- Peripheral Functions panel

- Code Preview panel

- Output panel

Open Help for Project Tree 
Panel

Project Tree panel-dedicated item
Displays the help of Project Tree panel.

Open Help for Property 
Panel

Property panel-dedicated item
Displays the help of Property panel.

Open Help for [Code Gen-
erator]panel

Peripheral Functions panel-dedicated item
Displays the help of Peripheral Functions panel.

Open Help for [Code Gen-
erator Preview]panel

Code Preview panel-dedicated item
Displays the help of Code Preview panel.

Open Help for Output 
Panel

Output panel-dedicated item
Displays the help of Output panel.
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This panel displays components of the project (microcontroller, design tool, build tool, etc.) in a tree structure.

Figure A.2 Project Tree Panel

The following items are explained here.

- [How to open]

- [Description of each area]

- [Context menu]

[How to open]

- From the [View] menu, select [Project Tree].

[Description of each area]

(1) Project tree area
This area displays components of the project (microcontroller, design tool, build tool, etc.) in a tree structure.

(a) Code Generator (Design Tool)
The sub-nodes of this node are [Peripheral Functions] and [Code Preview].

<1> [Peripheral Functions]
The sub-node of this node is the peripheral function node for the peripheral functions (clock generator, port 
functions, etc.) supported by the target device.

Icons that are displayed immediately to the left of each peripheral function node have the meanings listed 
below.

Project Tree panel

Peripheral function node Double-click on a peripheral function node or press the [Enter] key after 
selecting a peripheral function node to open the Peripheral Functions panel, 
which is used to make settings for control of the corresponding peripheral 
function.

Operation in the corresponding Peripheral Functions panel has been carried 
out.

Operation in the corresponding Peripheral Functions panel has not been car-
ried out.

 , The problem occurs on the settings became the manipulation to the other 
peripheral function node influences.

(1)



R20UT3104EJ0110  Rev.1.10 Page 30 of 50
Nov 01, 2017

CS+ Code Generator A.  WINDOWS REFERENCE

<2> [Code Preview]
The sub-node of this node is the peripheral function node for the peripheral functions (clock generator, port 
functions, etc.) supported by the target device.

Icons that are displayed immediately to the left of each peripheral function node have the meanings listed 
below.

[Context menu]

Peripheral function node Double-click on a source code node/API function node in the level of the hier-
archy below this node or select a source code node/API function node and 
press the [Enter] key to open the Code Preview panel, which is used to con-
firm that the source code corresponds to the settings in the Peripheral Func-
tions panel.

Operation in the corresponding Peripheral Functions panel has been carried 
out.

Operation in the corresponding Peripheral Functions panel has not been car-
ried out.

Return to Reset Value The default settings of the selected node are restored.

Property Opens the Property panel corresponding to the selected node.
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This panel allows you to view the information on and change the setting for the node selected in the Project Tree panel.

Figure A.3 Property Panel

The following items are explained here.

- [How to open]

- [Description of each area]

- [Context menu]

[How to open]

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)], and then select 
[Property] from the [View] menu.

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)], and then select 
[Property] from the context menu.

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Peripheral 
Functions] (>> Peripheral function node), and then select [Property] from the [View] menu.

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Peripheral 
Functions] (>> Peripheral function node), and then select [Property] from the context menu.

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Code Preview] (>> 
Peripheral function node >> Source code node >> API function node), and then select [Property] from the [View] 
menu.

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Code Preview] (>> 
Peripheral function node >> Source code node >> API function node), and then select [Property] from the context 
menu.

Remark 1. If this panel is already open, selecting a different [Code Generator (Design Tool)] in the Project Tree 
panel changes the content displayed accordingly.

Remark 2. If this panel is already open, selecting [Peripheral Functions] (>> Peripheral function node) in the Project 
Tree panel changes the content displayed to that corresponding to the selected node.

Remark 3. If this panel is already open, selecting [Code Preview] (>> Peripheral function node >> source code node 
>> API function node) in the Project Tree panel changes the content displayed to that corresponding to 
the selected node.

Property panel
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[Description of each area]

(1) Detail information display/change area
This area allows you to view the information on and change the setting for the node selected in the Project Tree 
panel.
The content displayed in this area differs depending on the node selected in the Project Tree panel.

(2) Tab selection area
In this panel, following tabs are contained (see the section explaining each tab for details on the display/setting on 
the tab).

- [Code Generator Setting] tab

- [Peripheral Function Information] tab (Product Information)

- [Peripheral Function Information] tab (Peripheral Function Information)

- [Code Preview Information] tab (Product Information)

- [Code Preview Information] tab (Peripheral Function Information)

- [Code Preview Setting] tab (File Information)

- [Code Preview Setting] tab (Function Information)

[Context menu]

Undo Cancels the effect of an edit operation to restore the previous state.

Cut Sends the character string or lines selected with range selection to the clipboard and 
deletes them.

Copy Sends the character string or lines selected with range selection to the clipboard.

Paste Inserts the contents of the clipboard at the caret position.

Delete Deletes the character string or the lines selected with the range selection.

Select All Selects all strings displayed in the item being edited.
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[Code Generator Setting] tab

This tab allows you to view the information (Generate File Mode and Product Information) on and change the setting for 
the [Code Generator (Design Tool)] selected in the Project Tree panel.

Figure A.4 [Code Generator Setting] Tab

The following items are explained here.

- [How to open]

- [Description of each area]

[How to open]

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)], and then select 
[Property] from the [View] menu.

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)], and then select 
[Property] from the context menu.

Remark If this panel is already open, selecting a different [Code Generator (Design Tool)] in the Project Tree 
panel changes the content displayed accordingly.
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[Description of each area]

(1) [Generate File Mode] category
This area allows you to view the information (API output control, Output folder, File generation control, Register 
files and Report type) on and change the setting for the [Code Generator (Design Tool)] selected in the Project 
Tree panel.

API output control Select the type of API functions to be output.

Output all API functions 
according to the setting

All API functions for the peripheral functions (clock 
generation circuit, voltage detection circuit, etc.) 
that is set for use in the Peripheral Functions panel 
are output.

Output only initialization 
API function

Of the API functions for the peripheral functions 
(clock generation circuit, voltage detection circuit, 
etc.) that are set for use in the Peripheral Functions 
panel, only those relating to initialization are output.

Text file encoding Select the encoding of the generated source file.

System Generate source files with the encoding which is 
set in Windows.

Unicode(UTF-8) Generate source files with Unicode(UTF-8)

Chinese
Simplified(GB2312)

Generate source files with
Chinese Simplified(GB2312)

Chinese
Traditional(Big5)

Generate source files with
 Chinese Traditional(Big5)

Latin-1(ISO) Generate source files with Latin-1(ISO)

Japanese(EUC) Generate source files with Japanese(EUC)

Japanese(Shift-JIS) Generate source files with Japanese(Shift-JIS)

ASCII Generate source files with ASCII

UTF-16LE Generate source files with UTF-16LE

UTF-16BE Generate source files with UTF-16BE

UTF-16 Generate source files with UTF-16

Japanese(JIS) Generate source files with Japanese(JIS)

Creation date Select the creation date into the file header of the generated source file.

Output date Output the creation date into the file header of
generate source files.

No date Does not output the creation date into the file 
header of generate source files.

Output folder Inputs the output destination folder.
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Remark Note that if the [Merge file] is selected in [File generate control], the number of left braces (“{”) and 
right braces (“}”) must match in the parts to be merged. When the numbers do not match, process-
ing for correct merging is not possible.

(2) [Product Information] category
This area allows you to view the information (Release Date and Version) for the [Code Generator (Design Tool)] 
selected in the Project Tree panel.

File generation control Click on this option to select the reaction to cases where a file having the same 
file name exists when the  button of the Peripheral Functions 
panel is clicked.

Do nothing if file exists If a file with the same name exists, a new file will 
not be output.

Merge file If a file with the same name exists, a new file is 
merged with the existing file.
Only the section between "/* Start user code ... . Do 
not edit comment generated here */" and "/* End 
user code. Do not edit comment generated here */" 
will be merged.

Overwrite file If a file with the same name exists, the existing file 
is overwritten by a new file.

Register files Click on this option to select whether or not to register the output file in the project 
when the  button of the Peripheral Functions panel is clicked.

Register the generated 
files to the project

Registers the file.

Not register the generated 
files to the project

Does not register the file.

Report type Selects the output format for the report files (two files: Function and Macro) that 
are output when [Save Code Generator Report] is selected from the [File] menu.

HTML file Outputs the files in the HTML format.

CSV file Outputs the files in the CSV format.

Release Date Displays the release date of the Code Generator (Design Tool).

Version Displays the version number of the Code Generator (Design Tool).
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[Peripheral Function Information] tab (Product Information)

This tab allows you to view the information (Product Information) for the [Peripheral Functions] selected in the Project 
Tree panel.

Figure A.5 [Peripheral Function Information] Tab (Product Information)

The following items are explained here.

- [How to open]

- [Description of each area]

[How to open]

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Peripheral 
Functions], and then select [Property] from the [View] menu.

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Peripheral 
Functions], and then select [Property] from the context menu.

Remark If this panel is already open, selecting [Peripheral Functions] in the Project Tree panel changes the con-
tent displayed to that corresponding to the selected node.

[Description of each area]

(1) [Product Information] category
This area allows you to view the information (Release date and Version) for the [Peripheral Functions] selected in 
the Project Tree panel.

Release date Displays the release date of the Code Generator (Design Tool).

Version Displays the version number of the Code Generator (Design Tool).
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[Peripheral Function Information] tab (Peripheral Function Information)

This tab allows you to view the information (Peripheral Function Information) for the peripheral function node selected in 
the Project Tree panel.

Figure A.6 [Peripheral Function Information] Tab (Peripheral Function Information)

The following items are explained here.

- [How to open]

- [Description of each area]

[How to open]

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Peripheral 
Functions] >> Peripheral function node, and then select [Property] from the [View] menu.

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Peripheral 
Functions] >> Peripheral function node, and then select [Property] from the context menu.

Remark If this panel is already open, selecting peripheral function node in the Project Tree panel changes the 
content displayed to that corresponding to the selected node.

[Description of each area]

(1) [Peripheral Function Information] category
This area allows you to view the information (Peripheral function name, Peripheral function error and Peripheral 
function used) for the peripheral function node selected in the Project Tree panel.

Peripheral function name Displays the name of the peripheral function.

Peripheral function error Displays whether or not the settings in the Peripheral Functions panel are correct.

No error Illegal settings have not been detected.

Input error Illegal settings have been detected.

Peripheral function used Indicates whether or not to use the peripheral function.
Note that whether or not a function is to be used depends on the settings in the 
Peripheral Functions panel corresponding to the selected node.

Used The peripheral function is to be used.

No The peripheral function is not to be used.
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[Code Preview Information] tab (Product Information)

This tab allows you to view the information (Product Information) for the [Code Preview] selected in the Project Tree 
panel.

Figure A.7 [Code Preview Information] Tab (Product Information)

The following items are explained here.

- [How to open]

- [Description of each area]

[How to open]

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Code Preview], and 
then select [Property] from the [View] menu.

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Code Preview], and 
then select [Property] from the context menu.

Remark If this panel is already open, selecting [Peripheral Functions] in the Project Tree panel changes the con-
tent displayed to that corresponding to the selected node.

[Description of each area]

(1) [Product Information] category
This area allows you to view the information (Release Date and Version) for the [Code Preview] selected in the 
Project Tree panel.

Release Date Displays the release date of the Code Generator (Design Tool).

Version Displays the version number of the Code Generator (Design Tool).
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[Code Preview Information] tab (Peripheral Function Information)

This tab allows you to view the information (Peripheral Function Information) for the peripheral function node selected in 
the Project Tree panel.

Figure A.8 [Code Preview Information] Tab (Peripheral Function Information)

The following items are explained here.

- [How to open]

- [Description of each area]

[How to open]

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Code Preview] >> 
Peripheral function node, and then select [Property] from the [View] menu.

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Code Preview] >> 
Peripheral function node, and then select [Property] from the context menu.

Remark If this panel is already open, selecting peripheral function node in the Project Tree panel changes the 
content displayed to that corresponding to the selected node.

[Description of each area]

(1) [Peripheral Function Information] category
This area allows you to view the information (Peripheral function name and Peripheral function used) for the 
peripheral function node selected in the Project Tree panel.

Peripheral function name Displays the name of the peripheral function.

Peripheral function used Indicates whether or not to use the peripheral function.
Note that whether or not a function is to be used depends on the settings in the 
Peripheral Functions panel corresponding to the selected node.

Yes The peripheral function is to be used.

No The peripheral function is not to be used.
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[Code Preview Setting] tab (File Information)

This tab allows you to view the information (File Information) on and change the setting for the source code node 
selected in the Project Tree panel.

Figure A.9 [Code Preview Setting] Tab (File Information)

The following items are explained here.

- [How to open]

- [Description of each area]

[How to open]

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Code Preview] >> 
Peripheral function node >> Source code node, and then select [Property] from the [View] menu.

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Code Preview] >> 
Peripheral function node >> Source code node, and then select [Property] from the context menu.

Remark If this panel is already open, selecting the source code node in the Project Tree panel changes the con-
tent displayed to that corresponding to the selected node.

[Description of each area]

(1) [File Information] category
This area allows you to view the information (Fine name, File used, Default name and Output folder) on and 
change the setting for the source code node selected in the Project Tree panel.

File name Inputs the name of the file
The name of the file can be changed by selecting [Rename] from the context 
menu after selecting the source code node in the Project Tree panel.

File used Indicates whether or not output to a file is to proceed when the  
button in the Peripheral Functions panel is clicked. Note that whether or not this 
option is used depends on the settings in the Peripheral Functions panel corre-
sponding to the selected node.

Yes A file is output.

No A file is not output.
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Default name Selects whether or not to restore the default name of the file.
Note that the default name of the file can be restored by selecting [Default] from 
the context menu after selecting the source code node in the Project Tree panel.

Yes The default name is restored.

No The default name is not restored.

Output folder Displays the output destination folder.
Note that the output destination folder can be changed by using [Generate File 
Mode] >> [Output folder] in the [Code Generator Setting] tab.
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[Code Preview Setting] tab (Function Information)

This panel allows you to view the information on and change the setting for the node selected in the Project Tree panel.

Figure A.10 [Code Preview Setting] Tab (Function Information)

The following items are explained here.

- [How to open]

- [Description of each area]

[How to open]

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Code Preview] >> 
Peripheral function node >> Source code node >> API function node, and then select [Property] from the [View] 
menu.

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Code Preview] >> 
Peripheral function node >> Source code node >> API function node, and then select [Property] from the context 
menu.

Remark If this panel is already open, selecting the API function node in the Project Tree panel changes the con-
tent displayed to that corresponding to the selected node.

[Description of each area]

(1) [Function Information] category
This area allows you to view the information (Function name, Function used and Default name) on and change the 
setting for the API function node selected in the Project Tree panel.

Function name Inputs the name of the API function.
Note that the name of the API function can be changed by selecting [Rename] 
from the context menu after selecting the API function node in the Project Tree 
panel.

Function used Selects whether or not to output the API function when the  but-
ton in the Peripheral Functions panel is clicked.

Generated The API function is output.

Ungenerated The API function is not output.
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Default name Selects whether or not to restore the default name of the API function.
Note that the default name of the API function can be restored by selecting 
[Default] from the context menu after selecting the source code node in the Proj-
ect Tree panel.

Yes The default name is restored.

No The default name is not restored.
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This panel allows you to configure the information necessary to control the peripheral functions (clock generator, port 
functions, etc.) provided.

Figure A.11 Peripheral Functions Panel

The following items are explained here.

- [How to open]

- [Description of each area]

[How to open]

- On the Project Tree panel, double-click [Project name (Project)] >> [Code Generator (Design Tool)] >> [Peripheral 
Functions] (>> Peripheral function node).

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Peripheral 
Functions] (>> Peripheral function node), and then press the [Enter] key.

- From the [View] menu >> [Code Generator 2], select [Peripheral Functions].

Remark If this panel is already open, pressing a different peripheral function button “  ,  , etc.” changes the 
content displayed in the Information setting area accordingly.

Peripheral Functions panel

(1)

(2)
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[Description of each area]

(1) Toolbar
This area consists of the following “peripheral function buttons”.
When there is peripheral function target microcontroller is not supporting, peripheral functionbutton is not 
disokayed.

(2) Information setting area
The content displayed in this area differs depending on the “peripheral function node” or “peripheral function but-
ton” selected or pressed when opening this panel.
See user’s manual for microcontroller for details on the items to be set.

Outputs the source code (device driver program) to the folder specified by select-
ing [Code Generator Setting] tab >> [Generate File Mode] >> [Output folder] in 
the Property panel.

 ,  , etc. Changes the content displayed in the Information setting area to information 
required for controlling peripheral functions.
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This panel allows you to confirm the source code in accord with the settings of the Peripheral Functions panel.

Figure A.12 Code Preview Panel

The following items are explained here.

- [How to open]

- [Description of each area]

- [Context menu]

[How to open]

- On the Project Tree panel, double-click [Project name (Project)] >> [Code Generator (Design Tool)] >> [Code 
Preview] >> Peripheral function node >> Source code node (>> API function node).

- On the Project Tree panel, select [Project name (Project)] >> [Code Generator (Design Tool)] >> [Code Preview] >> 
Peripheral function node >> Source code node (>> API function mode), and then press the [Enter] key.

- From the [View] menu >> [Code Generator 2], select [Code Preview].

Remark If this panel is already open, double-clicking the source code node (>> API function node) changes the 
content displayed in the Source code display area to that corresponding to the selected node.

[Description of each area]

(1) Source code display area
This area allows you to confirm the source code (device driver program) that reflects the information configured in 
the Peripheral Functions panel.
The following table displays the meaning of the color of the source code text displayed in this area.

Remark 1. You cannot edit the source code within this panel.

Remark 2. For some of the API functions, values such as the register value are calculated and finalized when 
the source code is generated (when the  button on the Peripheral Functions panel 
is pressed). For this reason, the source code displayed in this panel may not be the same as that 
would actually be generated.

Code Preview panel

Green Comment

Blue Reserved word for C compiler

Red Numeric value

Black Code section

Gray File name

(1)
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[Context menu]

Copy Sends the character string or lines selected with range selection to the clipboard.

Select All Selects all the messages displayed on the Source code display area.
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This panel displays operation logs for various components (design tool, build tool, etc.) provided by CS+.
The messages are classified by the message origination tool and displayed on the individual tabs.

Remark The Message area can be zoomed in and out by  in the tool bar, or by operating the mouse 
wheel while holding down the [Ctrl] key.

Figure A.13 Output Panel

The following items are explained here.

- [How to open]

- [Description of each area]

- [Context menu]

[How to open]

- From the [View] menu, select [Output].

[Description of each area]

(1) Message area
The output messages of each tool are displayed.
Note that the character colors/background colors of the message differ with the type of output message (and 
depend on the settings in the [General - Font and Color] category in the Option dialog box).

(2) Tab selection area
Select the tab that indicates the origin of message.
The following tabs are available for the Code Generator.

Caution Even if a new message is output on a deselected tab, tab selection will not automatically switch. In 
this case, " * " mark will be added in front of the tab name, indicating that a new message has been 
output. 

[Context menu]

Output panel

All Messages Displays operation logs for all components (design tool, build tool, etc.) provided 
by CS+ in order of output.

Code Generator Display only operation logs for the Code Generator out of those for various com-
ponents (design tool, build tool, etc.) provided by CS+.

Copy Sends the character string or lines selected with range selection to the clipboard.

Select All Selects all the messages displayed on the Message area.

Clear Deletes all the messages displayed on the Message area.

Tag Jump Jumps to the caret line in the editor indicated by the message (file, line, and column).

(1)

(2)
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Open Help for Message Displays help for the message on the current caret location.
This only applies to warning messages and error messages.
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This dialog box allows you to name and save a file.

Figure A.14 Save As Dialog Box

The following items are explained here.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- From the [File] menu, select [Save Output-Tab Name].

- From the [File] menu, select [Save Output-Tab Name As...].

[Description of each area]

(1) Folder location
This is for selection of the output destination folder (folder name).

(2) List of files
This area displays a list of files matching the conditions selected in Folder location and [Save as type].

(3) [File name]
Specify the name of the file (file name).

(4) [Save as type]
Select the type of the file (file type).

[Function buttons]

Save As dialog box

Save Outputs a file having the name specified in the [File name] and [Save as type] to the 
folder specified in the Folder location.

Cancel Ignores the setting and closes this dialog box.

(1)

(2)

[Function buttons]

(3)

(4)
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